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Introduction

LiveNote Exhibits allows you to create bundles containing transcripts and exhibits using West Publisher. You can 
import the bundles into West Case Notebook or West LiveNote. You also can send the bundles to others via e-
mail or on a CD. You can use a DVD if the file is very large. 

To use West Publisher, follow these steps:

1. Import transcripts into the bundle.

2. Import documents into the bundle.

3. Link the documents to the transcripts, if desired.

4. Save the bundle as an E-Transcript Bundle (PTZ) file.

5. Save the bundle on a CD, if desired.

Notes

• When you import a document into a bundle, it is converted to a text-searchable format using optical 
character recognition (OCR) technology.

• When you prepare a bundle to save on a CD, West Publisher includes West E-Transcript Bundle Viewer and 
other files with the PTZ file. West E-Transcript Bundle Viewer enables the recipient of the disc to open and 
view the bundle. If you choose to send the PTZ file alone, West E-Transcript Bundle Viewer can be 
downloaded at west.thomson.com. For information on saving a bundle on a CD, see ”Saving a Bundle on a 
CD” on page 17. 

• When you open a bundle from a CD, West E-Transcript Bundle Viewer remains active until you close it or 
turn off your computer. Therefore, you can remove the CD and still view the bundle or insert a different CD 
that contains a related video.

• When you import PTZ files, West Case Notebook or West LiveNote retains all transcripts, exhibits, links to 
exhibits from transcripts, and synchronized video information.
Introduction      1
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File Types for Importing Transcripts
You can import the following types of transcript files into West Publisher:

• LiveNote Evidence Format (LEF) files

• E-Transcript (PTX or EXE) files

• Publisher Bundle (bundle.xml) files

• E-Transcript Bundle (PTZ) files

• Portable Transcript (PTF) files

• ASCII (text only) files

• Extensible Markup Language (XML) files

• CT Summation (TRN) files

• Timaro Technologies Post-Production Time-Stamp (PTS) files

• Sanction II (MDB) files

File Types for Importing Documents
You can import the following types of document files into West Publisher:

•  Images

• TIF/TIFF (Tagged Image File Format)

• JPE/JPG/JPEG (Joint Photographic Experts Group)

• BMP (Bitmap)

• GIF (Graphic Interchange Format)

• JFX

• PDF (Portable Document Format)

• DOC/DOCX (Microsoft Word file)

• WP/WPD (Corel WordPerfect file)

• MSG (Microsoft Outlook file)

• HTM/HTML (Hypertext Markup Language)

• PEX (LiveNote document file)

• TXT (plain text file)

• RTF (Rich Text Format)
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1 Working with Transcripts

West Publisher makes it easy for you to quickly get started with creating bundles. When you access West 
Publisher, you can immediately begin to import transcripts and documents (Figure 1-1). 

Figure 1-1. West Publisher window

Importing Transcripts
The first step in working with West Publisher is importing one or more transcripts into the bundle. 

Note You can create a bundle by importing transcripts and documents concurrently from a West Case 
Notebook or West LiveNote case. For further information, see ”Creating Bundles from a West Case 
Notebook or West LiveNote Case” on page 15.

To import a transcript, complete these steps:

1. Click the New arrow on the toolbar and choose Transcript (from File) from the menu. The Import Wizard–
Transcript File dialog box is displayed (Figure 1-2). 
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2. Click Browse to display the Browse for Transcript Files dialog box. 

3. Choose a file type from the Files of type drop-down list. 

4. Select your transcript.

5. Click Open. The Import Wizard–Transcript File dialog box is redisplayed. 

6. Click Next. A message warning that the transcript has not been signed electronically may be displayed. Click 
Continue. The Import Wizard–Transcript Properties dialog box is displayed (Figure 1-3). 

Figure 1-3. Import Wizard–Transcript Properties dialog box

Note If the information is not entered for you, you must at least type a last name in the Last text box to import 
the transcript.

7. Type a comment in the Comment text box, if desired.

Figure 1-2. Import Wizard–Transcript File dialog box
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8. Click Finish. The Import Wizard–Import Summary dialog box is displayed. To import another transcript, click 
Again. If you do not want to import another transcript, click Close. The transcript is listed under Transcripts 
in the left pane and the text of the transcript is displayed in the right pane (Figure 1-4).

Figure 1-4. Imported transcript

Opening a Transcript
To open a transcript, double-click the transcript in the left pane. The transcript is displayed in the right pane.

Closing a Transcript
To close a transcript so that it is no longer displayed in the right pane, click the Close button ( ) on the 
transcript’s tab.

Saving a Transcript
You can save a transcript in the following file formats: E-Transcript (PTX), ASCII (TXT), Rich Text Format (RTF), 
Extensible Markup Language (XML), Portable Transcript (PTF), Summation (SBF), or Sanction II (MDB). For 
example, to save a transcript as a PTF file, complete these steps:

1. From the File menu, choose Save As. Then choose Transcript, PTF from the submenus. The Save As 
Portable Transcript Format dialog box is displayed. 

2. The file name for the transcript is entered for you in the File Name text box. Type a different name, if desired.

3. Click Save.

Deleting a Transcript 
To delete a transcript, right-click the transcript in the left pane and choose Delete from the menu. The message 
Permanently delete the selected transcript? is displayed. Click Yes.

Updating Transcripts
You can update West Publisher transcripts using the following types of files: 

• LiveNote Evidence Format (LEF) files—files containing transcripts, exhibits, exhibit links, and possibly 
synchronized video 

• E-Transcript (PTX or EXE) files—files containing transcript text and, if the transcript is signed, the signature 
details 
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• Publisher Bundle (bundle.xml) files—files containing transcripts, exhibits, exhibit links, and possibly 
synchronized video (the file can contain one transcript only) 

• E-Transcript Bundle (PTZ) files—files containing transcripts, exhibits, exhibit links, and possibly 
synchronized video (the file can contain one transcript only) 

• Portable Transcript (PTF) files—files containing transcript text and annotations, usually received from a 
West Case Notebook or West LiveNote user 

• ASCII (text only) files—files containing transcript text, usually received from a court reporter 

Note You can also import CT Summation (TRN) files, Timaro Technologies Post-Production Time-Stamp (PTS) 
files, and Sanction II (MDB) files.

 UPDATING WITH A LEF FILE 

LEF files may contain the transcript with exhibit files and links to exhibit references in the transcript, the 
transcript with exhibit files and links to exhibit references in the transcript and synchronized video, or the 
transcript with synchronized video but no exhibits or exhibit links. 

1. Click the New arrow on the toolbar and choose Update Draft Transcript (from File) from the menu. The 
Update Transcript–Transcript File dialog box is displayed. 

2. Click Browse to display the Browse for Transcript Files dialog box. 

3. Select the LEF file and click Open. The Update Transcript–Transcript File dialog box is redisplayed. 

4. The Replace existing text with new text check box is automatically selected. If there are no changes to the 
transcript text, clear the check box. 

5. The Import exhibits check box is automatically selected. If you do not want to import exhibits, clear the check 
box. 

6. Click Next. A message warning that the transcript has not been signed electronically may be displayed. Click 
Continue. 

7. When the Update Transcript–Transcript Properties dialog box is displayed, click Finish. The Update 
Transcript–Update Completed dialog box is displayed.

8. Click Close.

UPDATING WITH A PTX OR EXE FILE

1. Click the New arrow on the toolbar and choose Update Draft Transcript (from File) from the menu. The 
Update Transcript–Transcript File dialog box is displayed. 

2. Click Browse to display the Browse for Transcript Files dialog box. 

3. Select the PTX or EXE file and click Open. The Update Transcript–Transcript File dialog box is redisplayed. 

4. Click Next. A message warning that the transcript has not been signed electronically may be displayed. Click 
Continue. 

5. When the Update Transcript–Transcript Properties dialog box is displayed, click Finish. The Update 
Transcript–Update Completed dialog box is displayed.

6. Click Close. 

UPDATING WITH AN ASCII FILE 

1. Click the New arrow on the toolbar and choose Update Draft Transcript (from File) from the menu. The 
Update Transcript–Transcript File dialog box is displayed. 

2. Click Browse to display the Browse for Transcript Files dialog box. 

3. Select the ASCII file and click Open. (Different CAT systems create different extensions on ASCII files.) The 
Update Transcript–Transcript File dialog box is redisplayed. 
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4. Click Next. A message warning that the transcript has not been signed electronically may be displayed. Click 
Continue. The Update Transcript–Import Details dialog box is displayed.

5. Click Next. 

6. When the Update Transcript–Import Confirm dialog box is displayed, click Next. The Update Transcript–
Transcript Properties dialog box is displayed.

7. Type the last and first names of the deponent in the Last and First text boxes.

8. Click Finish. The Update Transcript–Update Completed dialog box is displayed.

9. Click Close.

UPDATING WITH A PTF FILE 

Use this method when you want to replace existing text with new text. 

1. Click the New arrow on the toolbar and choose Update Draft Transcript (from File) from the menu. The 
Update Transcript–Transcript File dialog box is displayed. 

2. Click Browse to display the Browse for Transcript Files dialog box. 

3. Select the PTF file and click Open. The Update Transcript–Transcript File dialog box is redisplayed.

4. The Replace existing text with new text check box is automatically selected. If there are no changes to the text 
and you want to only merge annotations, clear the check box. 

5. Click Next. A message warning that the transcript has not been signed electronically may be displayed. Click 
Continue. 

6. When the Update Transcript–Transcript Properties dialog box is displayed, click Finish. The Update 
Transcript–Update Completed dialog box is displayed.

7. Click Close. 

Printing Transcripts
You can print a full-size or condensed version of a transcript. It is recommended that you use the Print Preview 
and Page Setup features to customize the print output before printing a transcript. For example, to print a 
condensed transcript with the first three pages full-size, complete these steps:

1. Select the transcript you want to print under Transcripts in the left pane.

2. From the File menu, choose Print Preview, then choose Transcript, Condensed from the submenus. The 
Print Preview window with the transcript is displayed.

3. Click the Page Setup button ( ) on the toolbar to display the Page Setup–Condensed Transcript dialog box 
(Figure 1-5).

4. Click the Condensed tab.
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Figure 1-5. Page Setup–Condensed Transcript dialog box

5. In the Print these pages full-sized section, select The first _____ and the last ____ pages, then type 3 in the first 
text box.

6. Click Apply, then click OK. The Print Preview window is redisplayed.

7. To verify that you have set the correct options, browse the transcript in the Print Preview window. 

8. Click the Print icon. The Print dialog box is displayed.

9. Click OK.
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2 Working with Documents

Importing Documents
The second step in working with West Publisher is importing one or more documents into the bundle. To import 
a document, complete these steps:

1. Click the New arrow on the toolbar and choose Document (from File) from the menu. The Data Import 
Wizard–Document Files dialog box is displayed. 

2. Click Add to display the Open dialog box. 

3. Select your document and click Open. The Data Import Wizard–Document Files dialog box is redisplayed. 

4. Click Next. The Data Import Wizard–Document Properties dialog box is displayed (Figure 2-1). 

Figure 2-1. Data Import Wizard–Document Properties dialog box

5. The title of the document is displayed in Title text box. Type a new name for the document, if desired.

6. Choose a document type from the Type drop-down list, if desired.

7. Type the author’s name in the Author text box, or choose the name from the drop-down list, if desired.

8. Type the recipient’s name in the Recipient text box, or choose the name from the drop-down list, if desired.

9. Type a number in the Bates range and Through text boxes, if desired. 

10. Select the Document Date check box, if desired. When you select this check box, the current day’s date is 
entered in the text box automatically. Click the arrow to select another date.

11. The OCR check box is automatically selected if the document is an image file or PDF file. Select or clear the 
OCR check box, if desired. 
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12. Click Finish. The document is listed under Documents in the left pane and the full text of the document is 
displayed in the right pane (Figure 2-2). 

Figure 2-2. Imported document

LINKING DOCUMENTS

When you import a document that is referenced in a transcript, West Publisher automatically links the document 
to all references to that document in the transcript. For example, if you import a document named Exhibit 5 into 
a transcript that refers to Exhibit 5 in 10 places, West Publisher links Exhibit 5 to all 10 references. 

If you import multiple transcripts, you must specify the transcript to which you want the document linked. To 
select the transcript to which the document is linked, complete these steps: 

1. Follow steps 1–11 under ”Importing Documents” on page 9.

2. If you are importing a document referenced in a transcript, the Next button is available in the Data Import 
Wizard–Document Properties dialog box. Click Next. The Select Transcripts to Link–Transcript Files dialog 
box is displayed (Figure 2-3).

Figure 2-3. Select Transcripts to Link–Transcript Files dialog box

3. Select the transcript to which you want the document linked.

4. Click Finish. The document is listed under Documents in the left pane and the full text of the document is 
displayed in the right pane. 
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Using the Link Feature

Use the Link feature to manually link an imported document to a word or phrase in the transcript. For example, 
to link the document named Summary of Events to every instance of the word summary in a transcript, complete 
these steps:

1. Open the transcript to which you want to link the document.

2. Select the word summary in the transcript.

Note To have West Publisher find the first instance of the word or phrase you want to link, click the Link button 
to display the Link dialog box. Type the word or phrase in the Find text box and click Find Next. Then 
follow steps 4–6 below. 

3. Click the Link button ( ) on the Transcript toolbar. Or right-click summary and choose Link from the 
menu. The Link dialog box is displayed with the word summary entered for you in the Find text box (Figure 
2-4).

Figure 2-4. Link dialog box

4. Choose Summary of Events.doc from the Exhibit drop-down list.

5. Do one of the following to link the document:

• Click Link to link the document to that instance of summary. The next instance of summary is displayed. 
Repeat this step to link each instance. When you have finished linking, the message Publisher has finished 
searching the transcript is displayed. Click OK.

• Click Link All to link the document to all instances of summary. The message West Publisher has 
completed its search of the transcript and has made [___] links is displayed. Click OK.

6. Click Close in the Link dialog box. 

Figure 2-5. Transcript with linked exhibit
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After you link a document to a transcript, it becomes an exhibit and is listed in the Exhibits folder under the 
transcript in the left pane (Figure 2-5). Double-click a link reference to jump to its location in the transcript. Click 
the link in the transcript to display the linked document.

Deleting Links

To delete the links for a document, complete these steps:

1. Open the transcript with the links you want to delete.

2. Use either of the following methods to unlink a document:

• Right-click the word or phrase in the transcript that you want to unlink. Choose Unlink from the menu to 
unlink the word or phrase, or choose Unlink All to unlink all instances of the word or phrase.

• Click the Link button ( ) on the Transcript toolbar to display the Link dialog box. Choose the word or 
phrase you want to unlink from the Find drop-down list and click Find Next. The first instance of the linked 
word or phrase is displayed. Click Unlink All. 

3. The message West Publisher has completed its search of the bundle and has unlinked [____] documents is 
displayed. Click OK.

4. Click Close in the Link dialog box.

Importing Multiple Documents
To import multiple documents, complete these steps:

1. Click the New arrow on the toolbar and choose Document (from File) from the menu. The Data Import 
Wizard–Document Files dialog box is displayed. 

2. Click Add to display the Open dialog box (Figure 2-6). 

Figure 2-6. Open dialog box

3. Select your documents and click Open. The Data Import Wizard–Document Files dialog box is redisplayed 
(Figure 2-7). 
12      Working with Documents



Figure 2-7. Data Import Wizard–Document Files dialog box

Note For most file types, each file is imported as a separate document. For image files, you have the option of 
importing each file as a separate document or merging multiple files into one document. To merge 
multiple image files, make sure the Batch Import, each file is separate document check box is clear. To 
import each file as a separate document, select the check box.

4. Click Finish. The documents are listed under Documents in the left pane and the full text of the first listed 
document is displayed in the right pane. 

Opening a Document
To open a document, double-click the document in the left pane. The document is displayed in the right pane.

Deleting a Document 
To delete a document, right-click the document in the left pane and choose Delete from the menu. The message 
Permanently delete the selected document? is displayed. Click Yes.

Closing a Document
To close a document so that it is no longer displayed in the right pane, click the Close button ( ) on the 
document’s tab.
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3 Creating Bundles from a West Case 
Notebook or West LiveNote Case

West Publisher allows you to create a bundle by importing transcripts and documents directly from a case in 
West Case Notebook version 1.0 or later or West LiveNote version 1.0 or later. To create a bundle from a West 
Case Notebook or West LiveNote case, complete these steps:

1. Click the New arrow on the toolbar and choose Bundle from West LivNote from the menu. The Data 
Selection Wizard–Cases dialog box is displayed (Figure 3-1). 

Figure 3-1. Data Selection Wizard–Cases dialog box

2. Select a case and click Next. The Data Selection Wizard–Transcripts and Documents dialog box is displayed 
(Figure 3-2). 

Note To select a secure case, click Repositories. For further information on accessing secure cases, 
download a free copy of the West Case Notebook User Guide or the West LiveNote User Guide at 
west.thomson.com/support/user-guide/livenote-case-notebook.aspx.
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Figure 3-2. Data Selection Wizard–Transcripts and Documents dialog box

3. By default, all transcripts and documents are selected. To exclude transcripts or documents from being 
imported into West Publisher, clear the Transcripts or Documents check box. To exclude particular data 
from being imported, click the document type containing the data, then clear the check boxes for the data 
you want to exclude.

Note In the alternative, click Groups to import only data you added to a data group. Then select a data 
group in the Data Groups dialog box, and click OK. For further information about data groups, refer to 
the West Case Notebook User Guide or the West LiveNote User Guide.

4. Click Finish. The transcripts are listed under Transcripts and the documents are listed under Documents in 
the left pane.
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4 Working with Bundles 

Viewing Bundles in West E-Transcript Bundle Viewer
You can open your bundle in West E-Transcript Bundle Viewer to verify how the bundle looks if you saved it on a 
CD. To open the bundle in West E-Transcript Bundle Viewer, complete these steps:

1. Click the View Bundle button ( ) on the toolbar. 

2. If you did not save the bundle after making changes, the message Do you want to save the changes to the 
Bundle? is displayed. Click Yes. For more information, see “Saving Bundles” below.

3. If you selected the Display E-Transcript Bundle cover page check box when you created the bundle, the cover 
page is displayed (Figure 4-1). For more information, see ”Managing Cover Page Information” on page 19. 

4. To view the bundle, click the Close button on the cover page. 

Figure 4-1. E-Transcript Bundle cover page

To close the West E-Transcript Bundle Viewer, click the Close button.

Saving Bundles

SAVING A BUNDLE AS A PTZ FILE

To save a bundle as a PTZ file, complete these steps:

1. From the File menu, choose Save As, E-Transcript Bundle. The Save As dialog box is displayed. 

2. Type a file name for the bundle, e.g., Smith v Jones, in the File name text box.

3. Click Save. 

SAVING A BUNDLE ON A CD

When you use the E-Transcript Bundle Disk feature, West Publisher creates files that allow the bundle to open 
automatically from the CD using West E-Transcript Bundle Viewer. You do not need to have West Publisher 
installed to use the CD.
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To save a bundle to a CD, complete these steps:

1. In West Publisher, from the File menu, choose Save As, E-Transcript Bundle Disk. The Save As 
E-Transcript Bundle Disk dialog box is displayed.

2. Click the Create New Folder button to create a folder in which to save your bundle files.

3. Open the folder you created in step 2.

4. The file name for your bundle is entered for you in the File name text box. Type a different name, if desired. 

5. Click Save. 

6. On your hard disk drive, open the folder you created in step 2.

7. Select and copy all of the files contained in the folder, listed below:

• Bin folder

• autorun.inf 

• Viewer.exe 

• Smith v Jones.ptz 

8. Paste these files directly into the CD; do not put them in a separate folder. If there is a synchronized video or 
a Microsoft PowerPoint presentation associated with the bundle, you can also move them to the CD.

9. If you are using Windows Explorer to burn the files to the CD, right-click the CD and choose Write these files 
to CD from the menu. 

Entering Bundle Properties
The information you enter in the Bundle Properties dialog box in West Publisher is displayed on the 
E-Transcript Bundle cover page when you view the bundle. For more information, see ”Managing Cover Page 
Information” on page 19. 

1. Click the Bundle Properties button ( ) to display the Bundle Properties dialog box 
(Figure 4-2). 

Figure 4-2. Bundle Properties dialog box.

2. Type a name for the plaintiff, e.g., Smith, in the Plaintiff text box or, if you have previously saved other 
bundles, you can choose a name from the drop-down list.

3. Type a name for the defendant, e.g., Jones, in the Defendant text box, or choose a name from the drop-down 
list.

4. The case title is entered for you. To change the case title, type a new title in the Case title text box.

5. Type a matter number in the Matter # text box, if desired.

6. Choose a case type, e.g., Workers Compensation, from the Case Type drop-down list. 

7. Type a client name, e.g., John Smith, in the Client text box, or choose a name from the drop-down list.

8. Type a reference in the Reference text box, if desired.
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9. Select the Display E-Transcript Bundle cover page check box if you want to display the cover page when 
you view the bundle.

10. Click OK. The title of the bundle is displayed in the upper-left corner of the West Publisher window.

Managing Cover Page Information
The E-Transcript Bundle cover page contains the information from the Bundle Properties dialog box. You can 
also add your contact information and a logo to the cover page. If you selected the Display E-Transcript Bundle 
cover page check box when you created the bundle, the cover page is displayed when you view the bundle with 
West E-Transcript Bundle Viewer. For information on viewing the bundle, see ”Viewing Bundles in West E-
Transcript Bundle Viewer” on page 17. 

CHANGING BUNDLE PROPERTIES

To change the information for the bundle that is displayed on the E-Transcript Bundle cover page, click the 
Bundle Properties button ( ). The Bundle Properties dialog box is displayed. Enter the new information 
and click OK.

ADDING COVER PAGE INFORMATION

You can add your contact information and a logo to the E-Transcript Bundle cover page. To add information to 
the cover page, complete these steps:

1. From the Tools menu, choose Cover Page Information. The Cover Page Information dialog box is displayed 
(Figure 4-3).

Figure 4-3. Cover Page Information dialog box

2. Type your information in the appropriate text boxes.

3. Type the scheduling page information in the Scheduling page text box.

4. To add a logo, click Browse. The Locate Logo File dialog box is displayed. Select your logo image file and 
click Open. The file name is displayed in the Logo text box.

5. To preview the cover page, click Preview. The cover page is displayed. To return to the Cover Page 
Information dialog box, click the Close button.

6. When you have finished, click OK.
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Opening Bundles
To open a previously saved bundle, from the File menu, choose Open Bundle. The Open dialog box is displayed 
(Figure 4-4). 

Figure 4-4. Open dialog box

You can do one of the following to locate a bundle:

• Click Browse to display the Open dialog box. Choose Publisher 3 or 4 Bundle (bundle.xml) from the Files of 
type drop-down list, then select your file and click Open. The bundle is listed in the Open dialog box.

• Type a bundle title, client name, matter number, or reference in the Find text box, then choose an option 
from the In drop-down list and click Find Now. The bundle is listed in the Open dialog box.

Select the bundle you want to open and click OK. The bundle is displayed in the West Publisher window.
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5 Working with Video

Playing a Video
If a transcript has been synchronized with video, you can view the video using West E-Transcript Bundle Viewer. 
To view a video, complete these steps:

1. Open the bundle that includes a transcript with synchronized video. 

2. Click the View Bundle button ( ) on the toolbar. If you selected the Display E-Transcript Bundle cover 
page check box when you created the bundle, the cover page is displayed. To view the bundle, click the Close 
button on the cover page. 

3. Open the transcript with the video you want to view.

4. Click the video icon ( ) on the Transcript toolbar. The video is played in the left pane. 

Working with Video Clips

CREATING A VIDEO CLIP

If a transcript has been synchronized with video, you can convert the transcript text to a video clip and save it. To 
create a short video clip, complete these steps:

1. Follow steps 1–4 above to play the video.

2. Select the text in the transcript for which you want to create the video clip.

3. Click the Create Video Clip button ( ) in the left pane.The Create Video Clip dialog box is displayed (Figure 
5-1).

Figure 5-1. Create Video Clip dialog box

4. Type a description of the video clip in the Description text box.

5. Click OK. The video clip is listed under Video Clips in the left pane (Figure 5-2).
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Figure 5-2. Video clip

CHANGING THE VIDEO CLIP DESCRIPTION

To change the description of a video clip, select the video clip under Video Clips in the left pane and click the 
Properties button ( ). The Edit Video Clip dialog box is displayed. Type a different description in the Description 
text box and click OK.

DELETING A VIDEO CLIP

To delete a video clip, select the video clip under Video Clips in the left pane and click the Delete button ( ). The 
message Remove the selected video clip? is displayed. Click Yes.

PLAYING A VIDEO CLIP

To play a video clip, select the video clip under Video Clips in the left pane and click the Play button ( ). The 
video clip begins playing.

SAVING A VIDEO CLIP

To save a video clip, select the video clip under Video Clips in the left pane and click the Save button ( ). The 
Save As dialog box is displayed. The file name with the beginning page and line number is entered for you in the 
File name text box. Type a different name, if desired. Then click Save.
22      Working with Video



SAVING A VIDEO CLIP AS A MICROSOFT POWERPOINT FILE

To save a video clip as a Microsoft PowerPoint file, complete these steps:

1. Select the video clip under Video Clips in the left pane.

2. Click the Save button ( ). The Save As dialog box is displayed. 

3. The file name with the beginning page and line number is entered for you in the File name text box. Type a 
different name, if desired. 

4. Choose PowerPoint File (*.ppt) from the Save as type drop-down list.

5. Click Save. The video clip is displayed in a PowerPoint slide. 

Note It is recommended that you use short annotations for each PowerPoint slide. If you need a longer excerpt, 
create multiple PowerPoint files and save them at the same time.
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6 Using the Word Index

The Word Index contains an index of words and numbers in a transcript or document along with their 
corresponding page and line numbers. Use the Word Index to search for a term in the transcript or document. 
Type the term in the text box to the right of the transcript or document to display the pages and lines where the 
term is found in the transcript or document (Figure 6-1). 

To view the word or number in the transcript or document, click the page and line reference. 

Figure 6-1. Word Index

You can view the word or number in context when you view the bundle in the West E-Transcript Bundle Viewer. 
To view the word or number in context, point to the page and line reference in the Word Index. The question and 
answer in which the word or number appears is displayed. 

Note If you cannot view the word or number in context, from the Tools menu, choose Options. The Display 
Options dialog box is displayed. Click the Word Index tab, then select the Show Preview check box. Click 
OK. For further information, see ”Selecting Word Index Display Options” on page 26.

Type the word or number you 
want to search for in the Word 
Index text box.

Click the page and line 
reference to view the term in 
the transcript or document.
Using the Word Index      25



Selecting Word Index Display Options
You can access the Word Index display options when you are viewing the bundle in the West E-Transcript Bundle 
Viewer. From the Tools menu, choose Options. The Display Options dialog box is displayed (Figure 6-2). Click the 
Word Index tab. You can specify 

• whether you want to view your word in context when you point to the page and line reference in the Word 
Index.

• how much transcript or document text you want displayed when viewing a term in context. If you select QA 
Pair, the entire question and answer in which the word or number appears is displayed. In the alternative, 
you can designate the number of lines to be displayed above and below the word or number.

• the types of documents in which to display the Word Index.

Click OK to save the Word Index display options.

Figure 6-2. Display Options dialog box



7 Receiving a West Publisher Bundle on 
a Disc

When you receive a disc with a West Publisher bundle, simply insert the disc in your CD/DVD drive to 
automatically open the bundle. A cover page may be displayed. To view the bundle, click the Close 
button on the cover page. The West E-Transcript Bundle Viewer is displayed (Figure 7-1). 

Figure 7-1. West E-Transcript Bundle Viewer

Note If you receive more than one disc, you may have received a disc that contains a video associated 
with a transcript. Insert the second disc in your CD/DVD drive and copy the video to your hard 
disk drive or network.

You can do the following in the West E-Transcript Bundle Viewer:

• Open a transcript by double-clicking the transcript in the left pane. The transcript is displayed in 
the right pane. 

• Open a document by clicking Documents in the left pane, then double-clicking the document you 
want to view. The document is displayed in the right pane. 

• View a linked exhibit by clicking its link in the transcript. The exhibit is displayed in the right pane.

• Play a synchronized video associated with a transcript by opening the transcript, then clicking the 

video icon ( ) on the Transcript toolbar. The video is played in the left pane.

• Print a transcript or document by choosing Print, Transcript or Print, Document from the File 
menu.

• View the cover page by choosing Bundle Cover Page from the View menu.
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